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About SolarWinds 
SolarWinds, Inc develops and markets an array of network management, monitoring, and 
discovery tools to meet the diverse requirements of today’s network management and consulting 
professionals. SolarWinds products continue to set benchmarks for quality and performance and 
have positioned the company as the leader in network management and discovery technology. 
The SolarWinds customer base includes over 45 percent of the Fortune 500 and customers from 
over 90 countries. Our global business partner distributor network exceeds 100 distributors and 
resellers. 

Contacting SolarWinds 
You can contact SolarWinds in a number of ways, including the following: 

Team Contact Information 

Sales 

sales@solarwinds.com 
www.solarwinds.com 
1.866.530.8100 
+353.21.5002900 

Technical Support www.solarwinds.com/support 

User Forums www.thwack.com 
 

Conventions 
The documentation uses consistent conventions to help you identify items throughout the printed 
and online library. 

Convention Specifying 
Bold Window items, including buttons and fields. 
Italics Book and CD titles, variable names, new terms 

Fixed font File and directory names, commands and code examples, 
text typed by you 

Straight brackets, as in 
[value] Optional command parameters 

Curly braces, as in 
{value} Required command parameters 

Logical OR, as in 
value1|value2 

Exclusive command parameters where only one of the 
options can be specified 

 

http://www.solarwinds.net/�
http://www.solarwinds.net/support�
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SolarWinds Orion IP Address Manager Documentation 
The following documents are included in the SolarWinds Orion IP Address Manager 
documentation library: 

Document Purpose 

Administrator Guide Provides detailed setup, configuration, and 
conceptual information. 

Evaluation Guide 
Provides an introduction to Orion Network 
Performance Monitor features and instructions for 
installation and initial configuration. 

Page Help Provides help for every window in the Orion IP 
Address Manager user interface 

Release Notes 
Provides the latest information about known issues, 
and updates. The latest Release Notes can be 
found at www.solarwinds.com.  
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Chapter 1 

Introduction 

 IP Address Manager (Orion IPAM) leverages Orion NPM’s intuitive point-and-
click interface to allow you to easily investigate IP address space issues. By 
periodically scanning the network for IP address changes, Orion IPAM maintains 
a dynamic list of IP addresses and allows engineers to plan for network growth, 
ensure IP space usage meets corporate standards, and reduce IP conflicts. 
Using Orion IPAM, network engineers can discover non-responsive IP addresses 
and coordinate team access to address IP space and track changes. 

Why Install SolarWinds Orion IPAM 
Built on the enterprise Orion core, Orion IPAM allows network engineers to 
create, schedule, and share IP space reports from a single reporting engine. 
Finally, network engineers can monitor network devices for fault, performance, 
configuration, and now IP address health indicators. 

• Manage your entire IP infrastructure from an intuitive Web-Console 

• Consolidate your IP addresses into a single repository 

• Monitor DHCP Server and Scope capacity 

• Keep better records by periodically scanning your network for IP address 
changes 

• Create, schedule and share reports on the IP address space percent 
utilization 

• Keep network devices up by identifying and eliminating IP address conflicts 

• Coordinate team access to your address space with role-based access 
control and track changes 

• Identify non-responsive IP addresses to optimize your IP space 

Key Features of Orion IPAM 
 Orion IPAM provides the following valuable features to help manage IP 
addresses. These features are the foundation upon which IPAM is built.  

Microsoft DHCP support  

Monitor DHCP Servers and Scopes with capacity monitoring 

Alerting capabilities  
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Alert on high Subnet and DHCP Scope utilizations.  

Scheduled Scanning  

Schedule and automatically scan your network on a regular basis to ensure 
your IP space is correctly configured  

Scan Segmentation  

Allows to manage some IP addresses manually and others with automatic 
scanning to ensure your network is running smoothly 

Subnet Allocation Wizard  

Specify a supernet and subnet sizes and Orion IPAM automatically allocates 
the correct sized subnet for your network 

Change Auditing  

Enables you to investigate IP address issues by knowing who made what 
changes when 

User-defined Grouping  

Create your own unique groups to categorize IP addresses by department, 
geography, device vendor, or your own custom fields 

Global Search  

Track down any specific IP address on your entire network in seconds by 
performing a global search directly from the Orion IPAM web console 

Engineer’s Toolset Integration  

Integrate with SolarWinds Engineer’s Toolset for right-click access to your 
favorite network management troubleshooting tools  

Flexible Reporting  

Generate IP address reports using out-of-the-box templates that can be 
easily customized with a few mouse clicks; automate report creation and 
distribution 

IPv6 Capable  

 View and track dual-stacked IPv4 and IPv6 enabled devices 
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How Orion IPAM Works 
Orion IP Address Manager joins the proven performance and solidity of Orion 
NPM and extends Orion NPM functionality into the realm of IP address 
management. Using ICMP and SNMP calls to collect details from devices on 
your network, IPAM tracks and displays IP address usage, in addition to 
automatically marking IP addresses that are no longer in use. Additionally, calls 
to DHCP servers are made to retrieve lease and scope details. Change logs and 
user activity is stored for tracking and auditing purposes in the Orion NPM 
database. All statistics are accessible using the Orion web interface. 
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Chapter 2 

Installing and Configuring Orion IPAM 

Orion IPAM employs a simple, wizard-driven install process allowing you to 
quickly start managing your network. Refer to the following sections for more 
information about licensing, system requirements and detailed installation and 
configuration procedures.  

Licensing Orion IPAM 
Orion IPAM is licensed in accordance with the number of IP addresses you 
manage in one of three statuses; Used, Reserved and Transient. Unused and 
available IPs do not count towards managed IP count. The following licensing 
tiers of Orion IPAM are currently available: 

• IPAM IP1000 for managing up to 1024 managed IP addresses. 

• IPAM IP4000 for managing up to 4096 managed IP addresses. 

• IPAM IP16000 for managing up to 16384 managed IP addresses. 

• IPAM IPX for managing an unlimited number of managed IP addresses. 

Orion IPAM allows you to designate managed IP addresses for management up 
to your license limit using any of the following methods: 

• Importing your own network definitions and settings. For more information 
about importing network definitions and settings into Orion IPAM, see 
“Importing IP Addresses and Settings” on page 32. 

• Adding a range of IP addresses within a previously unfilled subnet. For more 
information about adding IP address ranges, see “Adding a Range of IP 
Addresses” on page 37. 

• DHCP Server and scope monitoring. For more information about adding 
DHCP servers, see "DHCP Scope MonitoringDHCP Scope Monitoring63" 

• Using the Subnet Allocation Wizard to create managed subnets, and then 
select IP addresses existing within your new managed subnets. For more 
information about the Subnet Allocation Wizard, see “Using the Subnet 
Allocation Wizard” on page 45. 
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Orion IPAM Requirements 
As an Orion module, Orion IPAM requires an installation of Orion NPM v9.5 
Service Pack 5. At this time, system requirements for Orion IPAM do not exceed 
Orion NPM requirements.  

Software Requirements 

Operating System 

Windows 2008 Server (32-bit or 64-bit, running in 32-bit mode) 
Windows 2003 Server (32-bit or 64-bit, running in 32-bit mode) R2 
IIS must be installed. SolarWinds recommends that Orion NPM 
administrators have local administrator privileges to ensure full 
functionality of local Orion NPM tools. Accounts limited to use of the 
web console do not require administrator privileges. 
Note: SolarWinds does not support installation of Orion NPM on 
Windows XP or Vista in production environments. If you are 
installing Orion NPM on these operating systems for evaluation 
purposes, you must confirm that Shared Memory, Named Pipes, 
and TCP/IP are enabled on remote databases. 

Web Server 

Microsoft IIS version 6.0 and later. DNS specifications require that 
hostnames be composed of alphanumeric characters (A-Z, 0-9), 
the minus sign (-), and periods (.). Underscore characters (_) are 
not allowed. For more information, see RFC 952. 
Note: SolarWinds neither recommends nor supports the installation 
of Orion NPM on the same server or using the same database 
server as a Research in Motion (RIM) Blackberry server. 

.NET Framework Version 3.5 or later 
SNMP Trap 
Services 

Windows operating system management and monitoring tools 
component 

SQL Server 

SQL Server 2005 Service Pack 1 (Express, Standard or Enterprise) 
SQL Server 2008 Express, Standard, or Enterprise 
The selected database instance must support mixed-mode or SQL 
authentication, and the following x86 components must be installed: 
 - SQL Server System Common Language Runtime (CLR) Types 
 - Microsoft SQL Server Native Client 
 - Microsoft SQL Server Management Objects 
You can use the following database select statement to check your 
SQL Server version, service pack or release level, and edition: 
select SERVERPROPERTY ('productversion'), 
SERVERPROPERTY ('productlevel'), 
SERVERPROPERTY ('edition') 
Note: SQL Express is unable to manage databases larger than 
4GB. It is limited to a single processor and will use no more than 
1MB RAM. Use a SQL Server instance for larger networks requiring 
larger databases. 

DHCP Monitoring Microsoft Server 2003/2008 

ESX Server 
Version 3.5 or later 
Note: VMware ESX Server version 3.5 or later is only required 
where Orion NPM is used to monitor VMware ESX Servers. 

    Web Console 
Browser 

Microsoft Internet Explorer version 6 or later with Active scripting 
Firefox 3.0 or later 
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Note: Orion IPAM v1.5 requires the installation Orion NPM 9.5 SP5. 

Installing Orion IPAM 
The following procedure guides you through the installation of Orion IPAM. 
Ensure that the server on which you install Orion IPAM meets or exceeds the 
stated requirements for both Orion Network Performance Monitor (Orion NPM) 
and Orion IPAM. For more information about Orion IPAM requirements, see 
“Orion IPAM Requirements” on page 8. Complete the following procedure to 
install Orion IPAM. 

To install Orion IP Address Manager: 

1. Log on to the Orion NPM server that you want to use for IP address 
management. 

Note: Consider backing up your Orion database before performing any 
upgrade. 

2. Navigate to your download location and launch the executable.  

3. Review the Welcome text, and then click Next. 

4. Accept the terms in the license agreement, and then click Next. 

5. Click Install, and then click Finish. 

6. Click Enter Licensing Information. 

7. If the computer on which you installed IPAM is connected to the 
Internet, complete the following procedure. 

a. Click I want to activate my license over the Internet. 

b. Browse to http://www.solarwinds.com/customerportal/. 

c. Login to the customer portal using your CustomerID and Password. 

d. Copy your IPAM Activation Key to the clipboard, and then paste it into 
the Activation Key field on the Activate IPAM window. 

e. Click Next. 

f. Enter your contact information. 

g. If you use a proxy server to access the Internet, check the Proxy 
Server checkbox, and then type the proxy address and port number. 

h. Click Next. 

8. When the Orion IP Address Manager Setup Wizard completes, click Finish. 

9. If the Configuration Wizard does not start automatically, click Start > All 
Programs > SolarWinds Orion > Configuration Wizard. 

10. Review the Orion Configuration Wizard welcome text, and then click Next. 

http://www.solarwinds.com/customerportal�
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11. Confirm that all services that you want to install are checked in the Service 
Settings window, and then click Next. 

12. Click Finish when the Orion Configuration Wizard completes. 

Checking License Status  
Orion IPAM provides a tool to display the current usage of your license by 
indicating the number of currently managed addresses. This number also 
appears in the bottom right of the Manage Subnets page. 

1. Click Start > All Programs > SolarWinds Orion > Orion IP Address 
Manager > Orion IP Address Manager Licensing. 

2. Click Restart IPAM Services to update the website with the license change. 

3. Click Close. 

Maintaining Licenses with License Manager 
SolarWinds License Manager is an easily installed, free utility that gives you the 
ability to migrate Orion licenses from one computer to another without contacting 
SolarWinds Customer Service. The following sections provide procedures for 
installing and using License Manager. 

Installing License Manager 
Install License Manager on the computer from which you are migrating currently 
licensed products. 

Note: You must install License Manager on a computer with the correct time. If 
the time on the computer is off by as little as 5 minutes, in either direction, from 
Greenwich Mean Time (GMT), you will be unable to reset licenses without calling 
SolarWinds Customer Service. Time zone settings do not affect and do not 
cause this issue. 

To install License Manager: 

1. Navigate to http://support.solarwinds.com/support/default.cfm. 

2. Provide your SolarWinds Customer ID and password, and then click Login. 

3. Click Downloads &  Updates in the left navigation pane. 

4. Locate the Download Licensed Software section of the page, and click 
SolarWinds License Manager. 

5. Unzip the downloaded file, and then run LicenseManager.exe. 

http://support.solarwinds.com/support/default.cfm�
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Using License Manager 
You must run License Manager on the computer where the currently licensed 
SolarWinds product is installed before you can move licenses to a new 
installation. The following procedure deactivates currently installed licenses that 
can then be transferred to a new installation. 

To deactivate currently installed licenses: 

1. Click Start > All Programs > SolarWinds > SolarWinds License Manager. 

2. Check products to deactivate on this computer, and then click Deactivate. 

3. Specify your SolarWinds Customer ID and password when prompted, and 
then click Deactivate. 

Note: Deactivated licenses are now available to activate on a new computer. 

When you have successfully deactivated your products, log on to the computer 
on which you want to install your products, and then begin installation. When 
asked to specify your licenses, provide the appropriate information. The license 
you deactivated earlier is then assigned to the new installation. 

Configuring Orion IPAM 
Orion IPAM provides an easily configurable, custom user interface. The following 
sections detail available options for configuring the customizable aspects of your 
Orion IPAM installation. 

Configuring Subnet Scan Settings 
Orion IPAM is capable of using both SNMP and ICMP scanning to continuously 
determine the status of your monitored network. The Subnet Scan Settings view 
allows you to select how Orion IPAM automatically scans your network for 
changes. 

To configure Orion IPAM subnet scan settings: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click IPAM Settings. 

3. Click Subnet Scans. 

4. Provide an appropriate value for the Transient Period. The Transient period 
must be a value from .2 to 340 days. 

Note: Orion IPAM continuously scans all managed IP addresses on your 
network. If a device fails to respond to any SNMP or ICMP requests for the 
period of time designated as the Transient Period, Orion IPAM changes the 
status of the unresponsive IP address from Used to Available. Any 
associated custom attribute will be overwritten. 
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5. If you want to collect device details using SNMP to scan your network 
subnets, complete the following steps: 

a. Check Enable SNMP Scanning in the SNMP Scanning section. 

b. Provide an appropriate number of SNMP Retries. 

c. Designate the SNMP Timeout for SNMP requests on your network. The 
timeout value is measured in milliseconds.  

6. ICMP is used by default to scan your network subnets for changes, 
complete the following steps to configure ICMP: 

a. Provide an appropriate number of Pings per address. 

b. Designate both the Delay between Pings and the Ping Timeout, in ms, 
for ICMP requests on your network. 

7. Click Save. 

Note: You can disable scanning on a per subnet basis. For more information 
about editing subnet properties, see “Editing Subnets” on page 44. 

Configuring DHCP Scan settings 
DHCP Scope Monitoring allows you to add/edit DHCP Servers or Scopes and 
configure the scan settings.  

To configure DHCP scan settings 

1. Click on the DHCP Scope Monitoring tab. 

2. Click Add New DHCP Server. 

3. Select the DHCP node to be added from the list of nodes. 

4. Choose or create the necessary Windows Credentials from the drop 
down list. Then click TEST to verify the credential.  

5. Select the Server Scan Settings. Default is set to 4 hours. 

6. If you want to automatically add new scopes and subnets after 
scanning, check the box. 

7. If you want to IPAM to scan using ICMP and SNMP to obtain 
additional IP Address details, check the Enable subnet scanning box 
and select the scanning interval. 

8. To finish, click ADD DHCP SERVER 

Note: Only Microsoft DHCP Servers on Windows 2003 and 2008 are 
supported. DHCP Servers must already be defined as Nodes within Orion 
NPM. 

Note: All Windows credentials are sent in clear text during configuration only. 
Consider updating credentials while locally logged into the IPAM server or over 
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an HTTPS connection. The Windows account specified within IPAM must be on 
the DHCP server and of the three following groups: DHCP Users, DHCP 
Administrators and or local Administrators. IPAM impersonates the specified 
account on the local computer in order gain access. If the IPAM computer is not 
within the same windows domain as the DHCP server, the IPAM computer must 
have the identical account and password. 

Managing Windows Credentials  
The Windows Credentials view allows you to configure and save Windows 
credentials for use when scanning DHCP devices on your network. The following 
sections provide instructions for managing Windows credentials for your devices. 

Adding Windows Credentials 
The following procedure helps you store Windows credentials for Orion IPAM. 
Orion IPAM attempts to communicate with your DHCP network devices using 
these credentials. 

To add a Windows Credential to Orion IPAM: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click IPAM Settings. 

3. Click Manage Windows Credentials for Scope scans. 

4. Click Add in the tool bar. 

5. Provide an appropriate Display Name for your new credential. 

Note: The Windows Credentials view uses the Display Name to reference 
the different Windows credentials you have saved. 

6. Enter the Password of your new credential. 

7. Click Save. 

Note: All Windows credentials are sent in clear text during configuration only. 
Consider updating credentials while locally logged into the IPAM server or over 
an HTTPS connection. The Windows account specified within IPAM must be on 
the DHCP server and of the three following groups: DHCP Users, DHCP 
Administrators and or local Administrators. IPAM impersonates the specified 
account on the local computer in order gain access. If the IPAM computer is not 
within the same windows domain as the DHCP server, the IPAM computer must 
have the identical account and password. 
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Managing SNMP Credentials  
The SNMP Credentials view allows you to configure and save SNMP credentials 
for use when scanning SNMP devices on your network. The following sections 
provide instructions for managing SNMP credentials for your devices. 

Adding SNMP Credentials 
The following procedure helps you store SNMP credentials for Orion IPAM. Orion 
IPAM attempts to communicate with your network devices using the credentials 
in the order they are entered. To change the SNMP credential order see 
Ordering SNMP Credentials page 10. 

To add an SNMP credential to Orion IPAM: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click IPAM Settings. 

3. Click SNMP Credentials. 

4. Click Add in the tool bar. 

5. Provide an appropriate Display Name for your new credential. 

Note: The SNMP Credentials view uses the Display Name to reference the 
different SNMP credentials you have saved. 

6. Select the SNMP Version of your new credential. 

Notes: 

• Orion IPAM uses SNMPv2c by default. If the credential you are adding is 
required to scan devices using the enhanced security features of 
SNMPv3, select SNMPv3 

• If you select SNMPv2c and you do not want Orion IPAM to use SNMP v1 
if an SNMPv2c request fails, confirm that Use SNMP v2 only is checked. 

7. If the default SNMP port for the devices requiring your new credential is 
not 161, provide the actual SNMP Port number for these devices. 

8. If you want to use either SNMPv1 or SNMPv2c for subnet scanning with 
your new SNMP credential, provide at least one valid read-only 
Community String for the devices you want to scan with your new 
credential. 

Note: Orion IPAM requires the public Community String, at minimum, for 
subnet scanning. 
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9. If you want to use SNMPv3 for subnet scanning with your new SNMP 
credential, you will need the following information: 

• SNMPv3 User Name and Context 

• SNMPv3 Authentication Method and Password/Key 

• SNMPv3 Privacy/Encryption Method and Password/Key 

10. Click Save. 

Ordering SNMP Credentials 
The following procedure provides the steps required to reorder stored SNMP 
credentials. Orion IPAM attempts SNMP communication using the stored 
credentials in the order provided. 

To order SNMP credentials in Orion IPAM: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click IPAM Settings. 

3. Click SNMP Credentials. 

4. Check the credentials you want to reorder, and then click Up or Down in the 
tool bar, as appropriate, to move selected credentials up or down, 
respectively, in the list of stored credentials. 

Editing SNMP Credentials 
The following procedure guides you through editing stored SNMP credentials 
Orion IPAM uses to monitor your network. 

To edit an SNMP credential in Orion IPAM: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click IPAM Settings. 

3. Click SNMP Credentials. 

4. Check the Display Name of the credential you want to edit, and then click 
Edit in the tool bar. 

5. If you want to edit the credential Display Name, provide the new Display 
Name for the selected credential in the designated field. 

Note: The SNMP Credentials view uses the Display Name to reference the 
different SNMP credentials you have saved. 
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6. If you want to edit the SNMP version of the selected credential, select a 
different SNMP Version for the selected credential. 

Notes: 

• Orion IPAM uses SNMPv2c by default.  

• If you select SNMPv2c and you do not want Orion IPAM to use 
SNMP v1, confirm that Do not drop down to SNMP v1 is checked. 

• If the credential you are editing is required to scan devices that 
require the enhanced security features of SNMPv3, confirm that 
SNMPv3 is selected. 

7. If you want to provide a different SNMP port number for the selected 
credential, provide the new SNMP Port number. 

8. If you want Orion IPAM to use either SNMPv1 or SNMPv2c for subnet 
scanning with the selected credential, provide at least one valid read-only 
Community String for the devices to scan with the selected credential. 

Note: Orion IPAM requires the public Community String, at minimum, for 
subnet scanning. 

9. If you want Orion IPAM to use SNMPv3 for subnet scanning with the 
selected credential, provide the following settings: 

• SNMPv3 User Name and Context 

• SNMPv3 Authentication Method and Password/Key 

• SNMPv3 Privacy/Encryption Method and Password/Key 

10. Click Save. 

Deleting SNMP Credentials 
Complete the following procedure to delete an SNMP credential from the 
credential library.  

To delete an SNMP credential from Orion IPAM: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click IPAM Settings. 

3. Click SNMP Credentials. 

4. Check the Display Name of the credential you want to delete, and then click 
Delete in the tool bar. 

5. Click Yes to confirm that you want to delete the selected credential. 
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Creating and Configuring Custom Fields 
Depending on the type of component, Orion IPAM provides a number of 
predefined text properties to help organize your network. Orion IPAM also offers 
the ability to add descriptive text fields to addresses, subnets, supernets, and 
groups. 

Note: The Orion Custom Property Editor capabilities are not integrated with the 
Orion IPAM module at this time. 

To create or edit an Orion IPAM custom field: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click IPAM Settings. 

3. Click IPAM Custom Fields. 

4. If you want to add a custom field, click Add. 

5. If you want to edit an existing custom field, check the field to edit, and 
then click Edit. 

6. Provide a Database Column for your custom field. The Database Column is 
the label used wherever Orion IPAM references the custom field you are 
defining in the Orion Web Console. 

7. Edit the Database Column entry, as appropriate. The value is the 
alphanumeric label used in the Orion IPAM table of your Orion database for 
the custom field you are defining. By default, Orion IPAM generates this 
value automatically. 

8. Edit the Description of this field as necessary. The Description text is 
displayed if the custom field you are defining may be edited. 

9. Provide a Max String Length for your custom field. The Max String Length 
sets a limit to the number of characters you may use for any value of the 
custom field you are defining. 

10. If you want to make this custom field available to all network 
components defined in Orion IPAM, check Add to Groups, Supernets, 
and Subnets. Making this custom field available to all network components 
defined in Orion IPAM gives you the option to edit this field whenever you 
edit any network component. 

11. If you want to make this custom field available to all IP addresses 
monitored by Orion IPAM, check Add to IP addresses. Making this 
custom field available to all IP addresses monitored by Orion IPAM gives you 
the option to edit this field whenever you edit any IP address. 

12. When you have completed configuration of your custom field, click Save. 
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Customizing the IP Address Manager View 
 The IP Address Manager view provides a highly customizable display of the 
current status of managed IP addresses on your monitored network. By default, 
the IP Address Manager view provides the following resources: 

• Top 10 Subnets by % IP Address Space Usage 

• Top 10 DHCP Scopes by % IP Address Space Usage 

• Search for IP Address 

• Custom List of Reports 

• Manage Subnets and IP Addresses 

• thwack Recent IP Address Manager Posts 

You can customize your IP Address Manager view by adding, deleting, or 
reordering any available Orion resources. 

To customize the IP Address Manager view: 

1. Click IP Address Manager in the Modules toolbar. 

2. Click Customize Page. 

3. If you want to change the column layout of your IP Address Manager 
view, click Edit and then configure the column layout of your view as follows: 

a. Select the number of columns under Layout. 

b. Provide the width, in pixels, of each column in the appropriate fields. 

c. If you have finished setting the column layout for your view, click 
Submit. 

4. If you want to add a resource, repeat the following steps for each resource 
that you want to add: 

a. Click + next to the column in which you want to add a resource. 

b. Click + next to a resource group on the Add Resources page to expand 
the resource group tree displaying all available resources for the group. 

c. Check the resources you want to add. 

d. If you have completed the addition of resources to the selected 
view, click Submit. 

5. If you want to delete a resource from a column, select the resource, and 
then click X next to the resource column. 

6. If you want to copy a resource in a column, select the resource, and then 

click  next to the resource column to copy the selected resource. 
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7. If you want to change the order in which resources appear in your view, 
select resources, and then use the arrow keys to arrange them. 

8. If you have finished configuring your view, click Preview. 

A preview of your custom view displays in a new window. A message acting 
as a placeholder may display in some assigned resource locations, and 
resources will display as empty if resource information has not been polled 
yet. For more information, see “Resource Configuration Examples” in the 
SolarWinds Orion Network Performance Monitor Administrator Guide. 

9. Close the preview window. 

10. If you still want to change aspects of your view, repeat the preceding 
steps as needed. 

11. If you are satisfied with the configuration of your view, click Done. 

Notes: 

• For more information about adding your customized view to menu bars 
as a custom item, see “Adding a Custom Menu Item” in the SolarWinds 
Orion Network Performance Monitor Administrator Guide. 

• For more information about assigning your customized view as the 
default view for a user, see “Editing User Accounts” in the SolarWinds 
Orion Network Performance Monitor Administrator Guide. 

Personalizing Manage Subnets and IP Addresses Views 
Depending on the network component currently selected, the right pane of the 
dual-paned Manage Subnets and IP Addresses view displays either the Network 
View or the IP Address view. Both the Network View and the IP Address View 
may be personalized by reordering their respective default column arrangements. 
To personalize either the Network View or the IP Address View, simply click a 
column header and drag it to your preferred location. Your view personalization is 
saved immediately, and it is retained for the next time you use Orion IPAM. 
Select which resources to add and resize the columns to fit your needs. 

Managing Orion IPAM Users 
As a site administrator, you can use role definitions to adaptively restrict user 
access, as necessary, to maintain security without limiting your ability to delegate 
required network management activities. The following sections describe how to 
use role definitions to manage Orion IPAM users. 

User Role Definitions 
Orion IPAM allows site administrators to securely grant varying privilege levels to 
different types of Orion IPAM users. The following user roles are available: 
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Read-Only 

Granted the basic level of access to Orion IPAM, Read-Only users are given 
read-only access to the following Orion IPAM views and features: 

• All Orion IPAM web console resources, including search and Top XX 
resources not previously limited by Orion NPM account limitations. For 
more information, see “Understanding the IP Address Manager 
Summary View” on page 28. 

• All IP address and network component properties and custom fields on 
the Manage Subnets and IP Addresses page. For more information, see 
“Manage Subnets and IP Addresses Page” on page 30. 

• The Chart View on the Manage Subnets and IP Addresses page. For 
more information, see “For more information, see “Manage Subnets and 
IP Addresses Page” on page 30. 

Operator 

Operators maintain the same rights granted to Read-Only users with the 
addition of the following abilities: 

• IP address property and custom field management, including the ability 
to edit IP address properties on portions of the network made available 
by the site administrator. For more information, see “Manage Subnets 
and IP Addresses Page” on page 30.  

• Addition and deletion of IP address ranges from portions of the network 
made available by the site administrator. For more information, see 
“Manage Subnets and IP Addresses Page” on page 30. 

• Subnet status selection on the Manage Subnets and IP Addresses page. 
For more information, see “Manage Subnets and IP Addresses Page” on 
page 30. 

Power User 

Power Users maintain the same rights granted to Operators with the addition 
of the following abilities: 

• Drag-and-drop reorganization of network components in the left pane of 
the Manage Subnets and IP Addresses view. For more information, see 
“Manage Subnets and IP Addresses Page” on page 30. 

• IP address and network settings import and export. For more information 
about importing and exporting see “Importing IP Addresses and Settings” 
on page 32 and “Importing IPs and Subnets Using the SolarWinds 
Engineer's Toolset 

•  
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To import subnets and IP Addresses from the Engineer'sToolset:  

1.   Locate the ToolsetIP Address Manager database on your Toolset server. 

Note: TheToolset IP Address Manager database has an .ipdbextension.  

2. Copy the Toolset IPAddress Manager database to an appropriate location on 
your Orion server. 

3. Open a CommandPrompt on the Orion server. 

4. Enter CD "\Program Files\SolarWinds\Orion\IPAM" 

5. Enter NET STOP "SolarWinds IPAM Information Service" 

6. Enter SolarWinds.IPAM.Init.exe -import <Fullpath to your Toolset IP Address 
Manager database> 

7. Enter NET START ''SolarWinds IPAM Information Service'' 

 

• Exporting IP Addresses and Settings” on page 33. 

• Supernet and group properties management, including the ability to edit 
supernet and group properties and custom fields on portions of the 
network made available by the site administrator. For more information, 
see “Manage Subnets and IP Addresses Page” on page 30. 

Administrator 

Administrators are granted the same access to Orion IPAM that is granted to 
Power Users with the following added privileges: 

SNMP credentials management. For more information see “7. Click Save. 

Note: All Windows credentials are sent in clear text during configuration only. 
Consider updating credentials while locally logged into the IPAM server or over 
an HTTPS connection. The Windows account specified within IPAM must be on 
the DHCP server and of the three following groups: DHCP Users, DHCP 
Administrators and or local Administrators. IPAM impersonates the specified 
account on the local computer in order gain access. If the IPAM computer is not 
within the same windows domain as the DHCP server, the IPAM computer must 
have the identical account and password. 
 

• Managing SNMP Credentials ” on page 13. 

• Custom fields management. For more information see “Creating and 
Configuring Custom Fields” on page 17. 

• Subnet scan settings configuration. For more information see “Managing 
Subnet Scans” on page 44. 

Default 
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The Default role will have full, unlimited access to the Orion IPAM 
application, if the user is an Orion NPM administrator. This role will act as 
read only for non-Orion administrators. 

Assigning User Roles  
Orion IPAM user roles are assigned using the Orion Web Console Account 
Manager. The following procedure assigns Orion IPAM user roles. 

To define Orion IPAM user roles: 

1. Click Admin in the Views menu bar. 

2. Click Account Manager in the Accounts grouping of the Orion Website 
Administration page. 

3. Select the Orion Web Console account corresponding to which Orion IPAM 
user role you are defining, and then click Edit. 

Note: For more information about Orion Web Console accounts, see 
“Managing Web Accounts” in the SolarWinds Orion Network Performance 
Monitor Administrator Guide. 

4. Expand User’s IP Address Manager Settings. 

5. Select the appropriate IPAM Role for the selected user. 

6. Click Submit. 
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Chapter 3 

Using Orion IPAM 

Orion IPAM gives you the ability to easily monitor IP address space usage and to 
optimally manage IP address availability on your network. The following sections 
describe the various tools Orion IPAM provides to keep you informed of your 
network capacity. 

Launching Orion IPAM 
As an Orion module, Orion IPAM may be launched both from the within the Orion 
Web Console and from the Windows Start menu, as follows: 

• To open Orion IPAM from within the Orion Web Console, click IP Address 
Manager in the Modules menu bar. 

• To open Orion IPAM from the Windows Start menu, click Start > All 
Programs > SolarWinds Orion > Orion IP Address Manager > Orion IP 
Address Manager. 

Networking Concepts and Terminology 
The following sections define the networking concepts and terminology that are 
used within Orion IPAM. Some Orion IPAM terms correspond specifically to 
status icons. For more information about the icons used in Orion IPAM, see 
“Orion IPAM Status Icons” on page 27. 

Available 

All addresses in defined groups, subnets, and supernets are, by default, 
considered Available until they are otherwise assigned unless they are 
typically reserved, as in the case of the network and broadcast addresses. In 
Orion IPAM, available IP addresses are indicated with a gray IP icon. For 
more information, see “Orion IPAM Status Icons” on page 27. 

Classless Inter-Domain Routing (CIDR) 

CIDR is the standard, scalable method for both designating and organizing 
IP addresses using variable-length subnet masking to optimize packet 
routing efficiency over the Internet. In the CIDR standard, IP address blocks 
are represented using an IP address with a suffix, as in 214.100.48.00/20, 
where the suffix, /20, indicates the number of leading bits in the binary form 
of the IP address corresponding to the intended subnet. 
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The following examples, with the leading bits of the binary expansion 
underlined, show equivalent representations of the same subnet: 

11010110.01100100.00111001.11010101 = 214.100.57.213/32 

11010110.01100100.00111001.11010000 = 214.100.57.208/28 

11010110.01100100.00111001.00000000 = 214.100.57.00/24 

11010110.01100100.00110000.00000000 = 214.100.48.00/20 

Using CIDR, network administrators have a great amount of flexibility in 
terms of defining the size of available IP address allocations. The basic 
formula for determining the size of a CIDR subnet is 32)(2 −= nS , where S = 
the number of available IP addresses and n = the CIDR suffix. The following 
table displays the correlation between the CIDR suffix (/n) and the number of 
available IP addresses, or hosts, for multiple, different CIDR suffixes. 

CIDR Suffix (/n) Available IP 
Addresses (S) CIDR Suffix (/n) Available IP 

Addresses (S) 

/31 2 /22 1022 = S - 2 

/30 2 = S - 2 /20 4094 = S - 2 

/28 14 = S - 2 /18 16382 = S - 2 

/26 62 = S - 2 /16 65534 = S - 2 

/24 254 = S - 2 /12 1048574 = S - 2 

Note: In subnets defined to contain more than 2 IP addresses, typically the smallest 
address identifies the subnet to the rest of the network and the largest address is 
designated as the broadcast address for all addresses contained within the subnet. 

 

As a simple example case of CIDR notation with respect to subnets, both 
214.100.50.20 and 214.100.61.45 are in the subnet 214.100.00.00/16 
because they both share the same sixteen leading bits, represented by the 
decimal digits 214.100. These two IP addresse  s also exist in an even 
smaller subnet, 214.100.48.00/20, as revealed when the two addresses 
are expressed in binary, as follows, where the twenty leading bits, which are 
identical, are underlined: 

11010110.01100100.00110010.00000100 = 214.100.50.04  

11010110.01100100.00111101.00101101 = 214.100.61.45 

11010110.01100100.00110000.00000000 = 214.100.48.00/20 
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Group 

In Orion IPAM, groups serve as containers for the subnets, supernets, and 
even other groups you define to organize and manage your network. For 
more information about creating and using groups in Orion IPAM, see 
“Managing Groups in Orion IPAM” on page 41. 

Reserved 

Typically, in subnets defined to contain more than 2 IP addresses, the 
smallest address—the network address—identifies the subnet to the rest of 
the network and the largest address—the broadcast address—is used to 
communicate to all addresses within the subnet. Both the network address 
and the broadcast address are considered to be Reserved for a defined 
subnet. In Orion IPAM, reserved IP addresses are indicated with a purple IP 
icon. For more information, see “Orion IPAM Status Icons” on page 27. 

Subnet 

A subnet is any logical or physical subdivision of a network consisting of a 
collection of IP addresses for which some number of the leading address 
bits, commonly called an IP address routing prefix, are identical. 

For example, as a simple case, both 214.100.50.20 and 214.100.61.45 
are in the subnet 214.100.00.00/16, as they both share the same sixteen 
leading bits, represented by the decimal digits 214.100. Less obviously, 
these two IP addresses exist in an even smaller subnet, 214.100.48.00/20, 
as revealed when the two addresses are expressed in binary, as follows, 
where the twenty leading bits, which are identical, are underlined: 

214.100.50.04 = 11010110.01100100.00110010.00000100 

214.100.61.45 = 11010110.01100100.00111101.00101101 

11010110.01100100.00110000.00000000 = 214.100.48.00/20 

Organizing your network using well-defined subnets can greatly increase the 
efficiency and minimize the bandwidth load on your network. At a basic level, 
assigning IP addresses to devices on your network in such a way that highly 
interactive devices reside within smaller or closer subnets reduces the 
amount of network traffic that must be routed over longer network distances. 
For more information about creating and managing subnets in Orion IPAM, 
see “Managing Subnets in Orion IPAM” on page 43. 

Supernet 

A supernet is an element of network organization consisting of contiguous 
CIDR blocks, or subnets. In networks with well-defined subnets, supernets 
allow network administrators to consolidate and limit IP traffic to optimize 
routing efficiency across a network. As an example, given the following two 
subnets, 222.22.12.0/24 and 222.22.10.0/24, 222.22.0.0/20 is a 
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supernet, as shown in the following expansions, where the underlining 
highlights the common address bits of the supernet. 

222.22.12.0/24 = 11011110.00010110.00001100.00000000 

222.22.10.0/24 = 11011110.00010110.00001010.00000000 

222.22.0.0/20  = 11011110.00010110.00000000.00000000 

Transient 

Orion IPAM  uses the term Transient to describe IP addresses that are 
dynamically assigned to devices. IP addresses designated as Transient may 
be assigned to any of the following types of devices: 

• devices that power on and off regularly like laptops or some user 
workstations 

• devices that enter and exit the network frequently, like laptops on a 
wireless network 

• any devices on a DHCP-enabled network 

 In Orion IPAM, Transient IP addresses are indicated with a cyan colored IP 
icon. For more information, see “Orion IPAM Status Icons” on page 27. 

Used 

The Used label is provided to indicate any IP address that is currently 
assigned and not otherwise available. For more information, see “Orion IPAM 
Status Icons” on page 27. 

Viewing Networks with Orion IPAM 
Orion IPAM provides direct insight into the organization and availability of IP 
addresses on your network. This information is displayed using the resources of 
the IP Address Manager view and the three views of the Manage Subnets and IP 
Addresses page. The following sections describe the information available on 
these views. 
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Orion IPAM Status Icons 
In Orion IPAM, network components are represented by colored icons indicating 
the extent to which each component is used, as shown in the following table. 

Icon Component Status Status Description 

 Group Used 
(Closed) 

The group is closed, but it contains at least 
one other component (group, subnet, or 
supernet). 

 Group Used 
(Opened) 

The group is open, and it cintains at least one 
other component (group, subnet, or 
supernet). 

 
Grey 

IP Address Available 

All addresses in defined groups, subnets, and 
supernets are, by default, considered 
Available unless they are typically reserved, 
as in the case of the network and broadcast 
addresses, or until they are otherwise 
assigned. 

 
Purple 

IP Address Reserved 

Typically, in subnets defined to contain more 
than 2 IP addresses, the smallest address—
the network address—identifies the subnet to 
the rest of the network and the largest 
address—the broadcast address—is used to 
communicate to all addresses within the 
subnet. Both addresses are considered to be 
Reserved for a defined subnet. 

 
Cyan 

IP Address Transient 

Addresses that are dynamically assigned to 
devices that may power on and off regularly 
or that may enter and exit the network 
frequently are designated as Transient. 

 
Yellow 

IP Address Used Any address currently assigned to a 
monitored device is considered Used. 

 
Red 

Subnet Critical At least 80 percent of all possible addresses 
in the subnet are designated as Used.  

 
Yellow 

Subnet Warning 60 to 80 percent of all possible addresses in 
the subnet are designated as Used. 

 
Green 

Subnet Good Less than 60 percent of all possible subnet 
addresses are designated as Used. 

 
Red 

Supernet Critical At least 80 percent of all possible addresses 
in the supernet are designated as Used. 

 
Yellow 

Supernet Warning 60 to 80 percent of all possible addresses in 
the supernet are designated as Used. 

 
Green 

Supernet Good 
Less than 60 percent of all possible 
addresses in the supernet are designated as 
Used. 
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Icon Component Status Status Description 

 
Red 

DHCP 
Scope Critical At least 80 percent of all possible addresses 

in the Scope are designated as Used. 

 
Yellow 

DHCP 
Scope Warning 60 to 80 percent of all possible addresses in 

the Scope are designated as Used. 

 
Green 

DHCP 
Scope Good 

Less than 60 percent of all possible 
addresses in the Scope are designated as 
Used. 

 
Disabled 

DHCP 
Scope Disabled DHCP scope is currently disabled. 

 

Understanding the IP Address Manager Summary View 
The IP Address Manager view is the interactive center of your managed IP 
network. The following sections describe the default resources available on this 
view for managing your network. 

Top 10 Subnets by % IP Address Space Usage 
The Top 10 Subnets by % IP Address Space Usage resource provides an easily 
accessible report of IP address availability by defined subnet. Defined subnets 
are listed in decreasing order of IP address space percentage used (% IP 
Address Space Used). For each defined subnet, this resource provides a 
colored bar graph indicating the percentage of the total IP address space of your 
network that is currently in use or reserved. To provide further detail, this 
resource displays both the number of IP addresses designated for a selected 
subnet (IPs Used) and the number of IP addresses currently available for 
assignment (IPs Available) such that the % IP Address Space Used value is 
calculated as follows: 

Subnet in IPs All
 AvailableIPs  Subnet in IPs All  Used Space  AddressIP % −

=
 

Top 10 DHCP Scopes by % IP Address Space Usage 
 This view displays the Top XX DHCP Scope availability. Defined Scopes are 
listed in decreasing order of IP address space percentage used (% IP Address 
Space Used). For each defined Scope, this resource provides a colored bar 
graph representing the percentage of IP address space available. To provide 
further detail, this resource displays both the number of IP addresses designated 
for a selected subnet (IPs Used) and the number of IP addresses currently 
available for assignment (IPs Available). 
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Search for IP Address 
The Search for IP Address resource allows you to search the Orion IPAM table of 
your Orion database for IP addresses you are managing with Orion IPAM. For 
more information about searching the Orion IPAM table of your Orion database, 
see “Searching for IP Addresses” on page 36. 

Custom List of Reports 
The Custom List of Reports resource provides a list of selected Orion reports. 
Any report that is either predefined or subsequently created using Orion Report 
Writer may be listed in this resource. For more information about creating your 
own custom Orion IPAM reports, see "Creating Reports with Orion IPAM" on 
page 53. 

To edit the displayed list of reports, click Edit in the resource title bar. The Edit 
Custom List of Reports page opens, and then you can select from available 
network reports to list in this resource and edit the resource Title and Subtitle. 

Manage Subnets and IP Addresses 
Clicking anywhere in the Manage Subnets and IP Addresses resource provides 
direct access to the Manage Subnets and IP Addresses page. For more 
information about the Manage Subnets and IP Addresses page, see “Manage 
Subnets and IP Addresses Page” on page 30. 

thwack Recent IPAM Posts 
thwack.com is the online SolarWinds community for network engineers. The 
thwack Recent IPAM Posts resource shows the most recent Orion IPAM-related 
posts submitted by users to the Orion IPAM forum. 

Clicking the title of any listed post opens the corresponding thwack.com post in a 
new browser. 

Clicking Edit gives you the option to set the Maximum Number of Posts to 
Display in the resource. Type the number of post titles you want to display in the 
resource, and then click Submit. 

Clicking View All opens the thwack.com Orion IPAM forum, where you can read 
all posts related to Orion IPAM. 
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Manage Subnets and IP Addresses Page 
The Manage Subnets and IP Addresses page is the primary management 
interface for Orion IPAM. The page is divided into two panes. The left pane 
displays your entire managed network as it is organized into subnets, supernets 
and groups. For more information about organizing your network with subnets, 
see “Managing Subnets in Orion IPAM” on page 43. For more information about 
organizing your network with supernets, see “Managing Supernets in Orion 
IPAM” on page 46. For more information about organizing your network with 
groups, see “Managing Groups” on page 41. 

Depending on the current selection in the left pane, the right pane contains two 
tabs, each of which provides one of the following views: IP Address, Network, 
and Chart. The following sections describe the information that is available on 
each these Manage Subnets and IP Addresses views. 

IP Address View 
The IP Address View displays whenever a subnet is selected, either in the 
Network View on the right or in the network organization pane on the left of the 
Manage Subnets and IP Addresses page. This view provides a list of all IP 
addresses that are within the selected subnet. This view can be filtered by 
selecting the DHCP Managed dropdown menu.  

Each IP address is listed with a selection of IP address properties. With the 
exception of Last Update, which is reported by Orion IPAM as the result of a 
network scan, values for displayed IP address properties are set using the Edit IP 
Address window. For more information about editing IP address properties, see 
“Adding IP Address” on page 36. 

Network View 
The Network View displays whenever a group or supernet is selected in the 
network organization pane on the left of the Manage Subnets and IP Addresses 
page. If a group is selected, this view provides a list of all other groups, 
supernets, and subnets that are defined within the selected group. If a supernet 
is selected, this view provides a list of all subnets that are defined within the 
selected supernet. 

The status of displayed network components is designated using colored icons. 
For more information about network component icons, see “Orion IPAM Status 
Icons” on page 27. 
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Each network component (group, subnet, and supernet) is listed with a selection 
of component properties. With the exception of Last Discovery, which is 
reported by Orion IPAM as the result of a network scan, values for displayed 
network component properties are set using the appropriate Edit Network 
Component Properties window. For more information about editing group, 
properties, see “Editing Groups” on page 42. For more information about editing 
subnet properties, see “Editing Subnets” on page 44. For more information about 
editing supernet properties, see “Editing Supernets” on page 47. 

Chart View 
The Chart View is always available in the right pane of the Manage Subnets and 
IP Addresses page, and it provides a concise, visual report of your IP address 
allocation for any network component selected in the network organization pane 
to the left. A pie chart displays the designated states monitored IP addresses, 
and an availability report displays both the percentage of all possible IP 
addresses in the selected group, subnet, or supernet that are present for 
monitoring and the percentage of present IP addresses that are available for 
assignment.  For more information about IP address states in Orion IPAM, see 
“Orion IPAM Status Icons” on page 27. 

 

DHCP Scope Monitoring Page 
The DHCP Scope Monitoring page is divided into two panes. The left pane 
displays your entire managed network as it is organized into Scopes or Servers. 
You can filter how these are grouped by using the drop down arrow. 

The right pane contains two tabs, each of which provides one of the following 
views: Scopes tab and the DHCP Servers tab. The following sections describe 
the information that is available on each these views. 

Scopes tab 
The Scopes View displays a list of all DHCP Scopes that are monitored with 
IPAM. Selecting a Scope switches the view to the Manage Subnets & IP 
Addresses view where all the IP Addresses within that scope are displayed. 
Information such as Type, Status, MAC address, DNS, Lease Expiration and 
Lease Remaining time frames are displayed. This selection of properties is 
reported by Orion IPAM as the result of a network scan. For more information 
about editing DHCP Scope properties, see “Monitoring DHCP Scopes in Orion 
IPAM” on page 36. 
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DHCP Servers tab 
The DHCP Servers View displays a list of all DHCP Scopes that are monitored 
with IPAM. Selecting a Server switches the view to the Manage Subnets & IP 
Addresses view where all the IP Addresses within that server are displayed. 
Information such as Type, Status, MAC address, DNS, Lease Expiration and 
Lease Remaining time frames are displayed. This selection of properties is 
reported by Orion IPAM as the result of a network scan. For more information 
about editing DHCP Server properties, see “Monitoring DHCP Servers on 
page 48. 

 

Importing IP Addresses and Settings 
Orion IPAM supports the import of IP addresses and settings from Microsoft 
Excel (.xls and .csv) files. The following table lists the types of network 
information that Orion IPAM can import directly. 

Importable Settings and Properties 

Comments Contact DNS 

Description IPv4 Address Last Boot Time 

Last Synchronization Machine Type Response Time 

Status System Location System Name 

System Object ID Vendor  

 

The following procedure imports IP addresses and settings into the Orion IPAM 
table of your Orion database. 

To import IP addresses and settings into Orion IPAM: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click IPAM Settings. 

3. Click IP Address & Subnet Import. 

4. Next to the File to Upload field, click Browse. 

5. Locate the file containing the IP addresses, subnets, or settings you want to 
import, and then click Open. 

6. Select the File Type for the file you want to upload, and then click Next. 

7. For each Spreadsheet Column value from the import file select a 
corresponding Database Column name to use in the Orion IPAM table of 
your Orion database. 

Notes: 
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• An IPv4 Address column is required for all imports. Confirm that at least 
one spreadsheet column maps to an IPv4 Address column in the Orion 
IPAM table of your Orion database. 

• Only rows appearing to have a valid IPv4 address are imported. 

• Orion IPAM uses the data in the first non-empty row of the imported file 
to suggest appropriate labels for the columns in the Orion IPAM table of 
your Orion database.  

• Attempt to map all unlabeled Spreadsheet Columns to a provided 
Database Column name. Orion IPAM provides a preview before any 
changes are made permanent. 

8. Click Next. 

9. If the spreadsheet column values from the import file do not match the 
column types you have selected for the Orion IPAM table of your Orion 
database, complete the following steps to correct the indicated mismatches, 
repeating as necessary: 

a. Hover over an incorrect value, as indicated by a red icon or underline, to 
determine the cause of the mismatch. 

b. Click Back to correct your column selections. 

c. Click Next. 

10. If the spreadsheet column values match the column types you have 
selected, click Next to complete the import. 

11. If a subnet does not exist for any of your imported IP addresses, click 
Next to create subnets for these orphaned IP addresses. For more 
information about creating and assigning subnets to orphaned IP addresses, 
see “Viewing and Managing Orphaned IP Addresses” on page 35. 

Importing IPs and Subnets Using the SolarWinds 
Engineer's Toolset 
 

To import subnets and IP Addresses from the Engineer'sToolset:  

1.   Locate the ToolsetIP Address Manager database on your Toolset server. 

Note: TheToolset IP Address Manager database has an .ipdbextension.  

2. Copy the Toolset IPAddress Manager database to an appropriate location on 
your Orion server. 

3. Open a CommandPrompt on the Orion server. 

4. Enter CD "\Program Files\SolarWinds\Orion\IPAM" 
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5. Enter NET STOP "SolarWinds IPAM Information Service" 

6. Enter SolarWinds.IPAM.Init.exe -import <Fullpath to your Toolset IP Address 
Manager database> 

7. Enter NET START ''SolarWinds IPAM Information Service'' 

 

Exporting IP Addresses and Settings 
Orion IPAM also allows you to export IP addresses and settings, including any 
custom fields you have defined, as Microsoft Excel (.xls and .csv) files. The 
following table lists the types of network information that Orion IPAM can export 
from the Orion IPAM table of your Orion database to a new spreadsheet. 

Exportable Settings and Properties 

Comments Contact DNS 

Description IPv4 Address Last Boot Time 

Last Synchronization Machine Type Response Time 

Status System Location System Name 

System Object ID Vendor  

 

The following procedure exports IP addresses and settings from the Orion IPAM 
table of your Orion database as columns in a new spreadsheet. 

To export IP addresses and settings from Orion IPAM: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses. 

3. If you want to export an entire group, click the parent group of the group 
you want to export in the network organization pane on the left, and then 
check the group in the Network View on the right. 

4. If you want to export an entire supernet, click a parent group or supernet 
of the supernet you want to export in the network organization pane on the 
left, and then check the supernets in the Network View on the right. 

Note: Before Orion IPAM can export any supernet, the supernet must be 
populated with at least one defined subnet. 

5. If you want to export an entire subnet, click a parent group or supernet of 
the subnet you want to export in the network organization pane on the left, 
and then check the subnets in the Network View on the right. 

Note: Orion IPAM can only export subnets that have been properly defined 
and populated with IP addresses. 
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6. If you want to export IP addresses, click the parent subnet of the IP 
address you want to export in the network organization pane on the left, and 
then check the IP addresses to export in the Network View on the right. 

7. Click Export in the toolbar. 

8. Check the columns you want to export. 

Note: The IPv4 Address column is selected automatically, and it becomes 
the first column in the generated spreadsheet. Each additional setting or 
property you check becomes an additional column in the generated 
spreadsheet. 

9. Click Export. 

10. When you are prompted to open or save the file, click Save. 

11. Provide an appropriate file name and location for the generated spreadsheet, 
and then click Save. 

Viewing and Managing Orphaned IP Addresses 
After importing of IP addresses from a spreadsheet it is possible that one or more 
IP addresses may have been imported without being assigned to a managed 
subnet. In order to properly manage your network, Orion IPAM requires that all IP 
addresses are assigned to a managed subnet, even if the managed subnet 
contains only a single IP address. If Orion IPAM is unable to locate a configured 
subnet for each imported IP address, the following warning banner displays 
above the Manage Subnets and IP Addresses view:  

X imported IP addresses do not have a parent subnet. These orphaned 
IP addresses will not appear in Orion until parent subnets are assigned.  

The following procedure assigns parent subnets to orphaned IP addresses to 
enable their management by Orion IPAM. 

Notes: 

• /31 is the smallest subnet that IPAM recognizes. To create a subnet with one 
IP address, create a /31 subnet and assign a single IP address to that 
subnet. 

• If you try to manage more IP addresses than your current license allows, 
Orion IPAM will add as many IP addresses as allowed. The remaining 
addresses will be added as orphaned IP addresses. 

To assign a parent subnet to an orphaned IP address: 

1. Click Assign parent subnets to orphaned IPs in the warning banner. 

2. Check a single orphaned IP address. 
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3. Click Assign Subnet. 

4. If you do not want to use the default Subnet Name provided by Orion 
IPAM, provide a new Subnet Name for the new parent subnet. Orion IPAM 
suggests both a Subnet Address and a CIDR prefix length based on the 
actual orphaned IP address. The default Subnet Name provided by Orion 
IPAM is a concatenation of the Subnet Address and the CIDR prefix length. 

5. If you do not want to use the default Subnet Address and CIDR prefix 
length provided by Orion IPAM, provide a new Subnet Address and an 
appropriate CIDR prefix length for the new parent subnet. 

Notes: 

• Orion IPAM suggests both a Subnet Address and a CIDR prefix length 
based on the actual orphaned IP address. For more information about 
CIDR and subnet addressing, see “Networking Concepts and 
Terminology” on page 23. 

• Orion IPAM instantly confirms the validity of provided Subnet Address 
and CIDR prefix length combinations. For more information about CIDR 
and subnet addressing, see “Networking Concepts and Terminology” on 
page 23. 

6. These fields are optional; provide a Description, VLAN ID, and Location for 
the new parent subnet. 

7. Use the slider to set the Scan Interval. 

8. If you do not want Orion IPAM to automatically scan your new parent 
subnet for changes, check Disable Automatic Scanning. 

9. Click Save when you have completed configuring your new parent subnet. 

Managing IP Addresses with Orion IPAM 
Orion IPAM automatically monitors all IP addresses in subnets defined with 2048 
IP addresses (/21 or 255.255.248.0 mask) or fewer. IP address ranges allow 
you to manage IP addresses in larger subnets. The following sections provide 
details with respect to managing IP addresses on your network. 

Adding IP Addresses 
To help you maintain an organized network, Orion IPAM does not allow for the 
addition of an individual IP address unless it exists within a subnet previously 
designated for monitoring. The following options are available for adding IP 
addresses to Orion IPAM: 

• A range of IP addresses can be added to any defined subnet. This is usually 
done when you want to monitor specific addresses within a large subnet. For 
smaller subnets containing 2048 or fewer IP addresses (/21 or 
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255.255.248.0 and higher mask), Orion IPAM automatically monitors all 
included IP addresses. For more information, see “Adding a Range of IP 
Addresses” on page 37. 

• IP addresses may be added for monitoring by adding a parent subnet into 
any existing group, supernet, or subnet that Orion IPAM is already 
monitoring. Adding such a subnet is a straightforward process. For more 
information about adding subnets, see “Creating Subnets” on page 43. 

• The Subnet Allocation Wizard allows you to directly define subnets and 
allocate included IP addresses. For more information about the Subnet 
Allocation Wizard, see “Using the Subnet Allocation Wizard” on page 45. 

Adding a Range of IP Addresses 
Particularly in the case of larger subnets, it can be useful to deal with IP 
addresses in terms of defined IP address ranges, such as 6.6.16.1—6.6.16.15 
in a 6.6.16.0 / 20 subnet. The following procedure provides the steps required 
to add a range of IP addresses within a defined subnet. 

Note: By default, Orion IPAM displays all IP addresses in a subnet if the selected 
subnet contains 2048 or fewer IP addresses (/21 or 255.255.248.0 and higher 
mask). For these smaller subnets, it is not necessary to add IP address ranges 
for monitoring unless you have previously deleted the addresses in the range you 
want to add. 

To add a range of IP addresses within a defined subnet: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses  

3. In the network tree pane on the left, click the subnet into which you want to 
add your new range of IP address range. 

Note: For subnets with more than 2048 IP addresses (lower than /21 or 
255.255.248.0 mask), the right pane displays No IP addresses have 
previously been added unless you have already added a range of IP 
addresses within the selected subnet. 

4. Click IP Range > Add in the IP Address view in the right pane. 

5. Provide both the Starting IP Address and the Ending IP Address of your 
new IP address range. Orion IPAM will not allow IP address ranges defined 
outside the subnet indicated in the Parent Address field. 

6. Click Save. 
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Deleting IP Addresses from Monitoring 
Complete the following procedure provides the steps required to delete 
monitored IP addresses from within a defined subnet. If a defined subnet 
contains more than 2048 IP addresses (lower than /21 or 255.255.248.0 
mask), Orion IPAM only displays IP addresses in previously added ranges. For 
these larger subnets, you must add IP address ranges for monitoring before 
Orion IPAM can display addresses that may be deleted. 

To delete IP addresses from within a defined subnet: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses. 

3. Click the subnet from which you want to delete a range in the left tree pane 
of IP addresses. 

Note: For subnets with more than 2048 IP addresses (lower than /21 or 
255.255.248.0 mask), the right pane displays No IP addresses have 
previously been added unless you have already added a range of IP 
addresses within the selected subnet. 

4. Check the IP addresses to delete in the right pane IP Address view. 

5. Click IP Range > Remove. 

6. Click Yes to confirm the deletion, and then click Save. 

Setting IP Address Status 
The status of any monitored IP address within a defined subnet may be set from 
the IP Address View on the Manage Subnets and IP Addresses page, as shown 
in the following procedure. 

Note: If a subnet contains more than 2048 IP addresses (lower than /21 or 
255.255.248.0 mask), Orion IPAM only displays IP addresses in previously 
added ranges. For these larger subnets, you must add IP address ranges for 
monitoring before Orion IPAM can display addresses that may be managed. 

To set the status of an IP address within a defined subnet: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses, and then click the subnet 
containing the IP address for which you want to set the status in the left tree 
pane. 

Note: For subnets with more than 2048 IP addresses (lower than /21 or 
255.255.248.0 mask), the right pane displays No IP addresses have 
previously been added unless you have already added a range of IP 
addresses within the selected subnet. 
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3. Check the IP addresses to modify in the right pane IP Address view. 

4. Click Set Status, and then select the appropriate status. For more 
information about the definition of available status icons, see “Orion IPAM 
Status Icons” on page 27. 

Editing IP Address Properties 
Orion IPAM can store a wide array of information about the devices to which IP 
addresses are assigned. The following table lists the properties Orion IPAM can 
record in the Orion IPAM table of your Orion database. 

IP Address Properties 

Comment DNS IPv6 Address 

Last Credential Last Response Time Last Synchronization 

MAC Address Machine Type Node Alias 

Status System Contact System Description 

System Location System Name Type 

Vendor Static Dynamic 

 

You can edit IP address properties directly from the IP Address View on the 
Manage Subnets and IP Addresses page. The following procedure provides the 
steps required to edit the properties of an IP address within a defined subnet. 

Note: If a defined subnet contains more than 2048 IP addresses (lower than /21 
or 255.255.248.0 mask), Orion IPAM only displays IP addresses in previously 
added ranges. For these larger subnets, you must add IP address ranges for 
monitoring before Orion IPAM can display addresses that may be managed. 

To edit an IP address within a defined subnet: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses. 

3. Click the subnet containing the IP address you want to edit in the left tree 
pane. 

Note: For subnets with more than 2048 IP addresses (lower than /21 or 
255.255.248.0 mask), the right pane will display No IP addresses have 
previously been added unless you have already added a range of IP 
addresses within the selected subnet. 

4. Check the IP address to edit in the in the right IP Address view pane. 
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5. Click Edit and then select or provide appropriate values for each listed IP 
address property. 

Note: If you have defined custom fields for IP addresses, they are available 
for editing. For more information about configuring custom fields in Orion 
IPAM, see “Creating and Configuring Custom Fields” on page 17. 

6. Click Save when you have completed configuration of IP address properties. 

Note: The Skip Scan option will not modify values normally overwritten by 
network scanning.  

Searching for IP Addresses  
Orion IPAM provides a powerful yet straightforward and easy-to-use network 
search ability with the Search for IP Address resource on the IP Address 
Manager view. The following table provides available search criteria. 

Search Criteria Description 

Alias Search by the address alias 

Comments Search for a specific comment 

Contact Search for a contact name 

DNS Search using the DNS 

Description Search by an address description 

IPv4 Address Search for a IPv4-formatted address 

IPv6 Address Search for a IPv6-formatted address 

MAC Address Search by a specific MAC address 

Machine Type Search by the machine type 

Status Search by status; Used, Available, Reserved, Transient 

System Location Search by a physical location 

System Name Search by system name 

Custom Property Search by a custom property 

 

The following procedure shows how to use the Search for IP Address resource to 
search the Orion IPAM table of your Orion database. 

To search the Orion IPAM table of your Orion database: 

1. Click IP Address Manager in the Modules menu bar. 

2. Check criteria relevant to your search in the Search for IP Address resource.  



 

 
Using Orion IPAM  41 

3. Type a string or IP address and then click Search. 

Note: Wildcards (*,?) are permitted, as shown in the following examples: 
Cisco*, 10.15.*.*, W?ndows, Server-*, *.SolarWinds.com 

Orion IPAM queries the Orion IPAM table of your Orion database and displays a 
list of IP addresses matching the provided criteria. Each IP address is listed, in 
numerical order, with the following information, if available: 

• DNS 

• Status 

• System Description 

• System Location 

• System Contact 

• Comments 

Clicking any listed IP address opens the IP Address View for that IP address. 
From the IP Address View you can edit properties and set the status of the 
selected IP address. For more information about the IP Address View, see 
“Understanding the IP Address View” on page 30. 

Managing Groups in Orion IPAM 
Orion IPAM provides groups as a general aid to network organization. The 
drag-and-drop user interface makes it easy to create groups that contain any 
number of other groups, supernets, subnets or individual IP addresses. For 
example, in the case of a large network spread over multiple offices, each with its 
own sales, marketing and development, departments, Orion IPAM allows you to 
create groups to organize your entire network: 

BranchOffice1 BranchOffice2 BranchOffice3 BranchOffice4 

Sales1 Sales2 Sales3 Sales4 

Marketing1 Marketing2 Marketing3 Marketing4 

Development1 Development2 Development3 Development4 

 

Each branch office unit may have its own assigned IP addresses or subnet of 
your entire network. Using Orion IPAM, you can group all the various network 
components related to each department of each branch office into its own group. 
The following sections provide general instructions for creating and editing IP 
network groups in Orion IPAM. 
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Creating Groups 
The following procedure creates a group for organizing your network 
components. 

To create a network group: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses. 

3. Click the network or group into which you want to add your new group in the 
left network tree pane. 

4. Click Add > Group. 

5. Provide an appropriate Group Name and Description for your new group. 

6. If you have defined custom fields for groups, provide appropriate values 
in the available custom fields. For more information about configuring custom 
fields in Orion IPAM, see “Creating and Configuring Custom Fields” on 
page 17. 

7. Click Save. 

8. Drag-and-drop other groups, subnets, and supernets into your new group to 
organize your network. 

Editing Groups 
The following procedure edits the properties of an existing group. 

To edit an existing network group: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses . 

3. Click the group you want to edit in the left tree pane. 

4. Click Properties. 

5. Edit the existing Group Name and Description as appropriate. 

6. If you have defined custom fields for groups, edit the values in the 
available custom fields, as necessary. For more information about 
configuring custom fields in Orion IPAM, see “Creating and Configuring 
Custom Fields” on page 17. 

7. Click Save. 
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Managing Subnets in Orion IPAM 
Subnet creation and editing are primary functions Orion IPAM provides for 
network managers. The following sections detail the creation and editing of 
subnets with Orion IPAM. 

Creating Subnets 
Orion IPAM provides two methods for creating subnets. The Orion IPAM Subnet 
Allocation Wizard creates subnets within a designated supernet based on a 
desired subnet size. For more information about the Subnet Allocation Wizard, 
see “Using the Subnet Allocation Wizard” on page 45. The second method 
creates individual subnets within selected subnets, supernets, and groups, 
directly from the Manage Subnets and IP Addresses page, as shown in the 
following procedure. 

Note: /31 is the smallest subnet that IPAM recognizes. To create a subnet with 
one IP address, create a /31 subnet and assign a single IP address to that 
subnet. 

To create a new network subnet: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses. 

3. In the network tree pane on the left, click the network, group, or supernet into 
which you want to add your new subnet. 

4. Click Add > Subnet. 

5. Provide an appropriate Subnet Name for your new subnet.If you leave this 
field empty, Orion IPAM automatically generates a name based on the 
Subnet Address and CIDR prefix length you provide. 

6. Provide a new Subnet Address and an appropriate CIDR prefix length for 
the new subnet. 

Note: Orion IPAM instantly confirms the validity of provided Subnet Address 
and CIDR prefix length combinations. For more information about CIDR and 
subnet addressing, see “Networking Concepts and Terminology” on page 23. 

7. If you want to further identify your new subnet, provide a Description, 
VLAN ID, or Location for the new subnet. 

8. If you have defined custom fields for subnets, provide appropriate values. 
For more information about configuring custom fields in Orion IPAM, see 
“Creating and Configuring Custom Fields” on page 17. 

9. Use the slider to set the Scan Interval. 
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10. If you do not want Orion IPAM to automatically scan your new subnet 
for changes, check Disable Automatic Scanning. 

11. Click Save when you have completed configuring your new subnet. 

You can now drag-and-drop your new subnet into other groups and supernets, to 
organize your network. 

Editing Subnets 
The following procedure edits the properties of an existing subnet. 

To edit an existing network subnet: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses. 

3. Click the subnet you want to edit in the left tree pane. 

4. Click Properties. 

5. Edit the existing Subnet Name and the CIDR prefix length for your subnet. 

6. Edit the Description, VLAN ID, or Location for your subnet, as necessary. 

7. Click Save when you have completed configuring your subnet. 

Managing Subnet Scans 
Orion IPAM is capable of conducting both automatic and manual scans of 
monitored subnets, and the Subnet Scan Status view displays all subnet scans 
that are either currently in progress or scheduled for completion. Subnet scans 
are listed according to the Database Column property for each scanned subnet. 
For more information about subnet properties, see “Editing Subnets” on page 44. 
For each subnet scan listed, the Subnet Scan Status view displays the following: 

• Status provides the time when the next scan of the corresponding subnet will 
begin. If the scan is in progress, Status displays the time elapsed since the 
scan started. 

• The Scan Type is either Automated or  

• Last Discovery indicates the date and time when the corresponding subnet 
was last scanned. 

The following procedure provides the steps required to manage subnet scans 
from the Subnet Scan Status view. 

To manage subnet scans: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click IPAM Settings. 
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3. Click View subnet scan status in the Subnet Scans grouping. 

4. If you want to change the settings of any listed subnet scan, click Edit at 
the end of the corresponding row. 

Clicking Edit at the end of a listed subnet scan row opens the Edit Subnet 
Properties window wherein you can enable or disable automatic scanning and 
set an appropriate scan interval for the selected subnet. For more information 
about editing subnet properties, see “Editing Subnets” on page 44.  

Using the Subnet Allocation Wizard 
Orion IPAM provides the Subnet Allocation Wizard to help you most efficiently 
organize your managed IP address space into subnets that are sized 
appropriately for the extent and traffic of your network. With its realtime subnet 
calculator, the Orion IPAM Subnet Allocation Wizard allows you to quickly 
determine the most efficient way to subdivide any supernet, as shown in the 
following procedure. 

To create subnets from supernets using the Subnet Allocation Wizard: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses. 

3. In the network tree pane on the left, click Add > Subnet Allocation Wizard. 

4. Type the address of the supernet to divide in the Supernet Address field. 

5. Select an appropriate CIDR prefix length. 

Note: Orion IPAM instantly confirms the validity of provided Supernet 
Address and CIDR prefix length combinations. For more information about 
CIDR, see “Networking Concepts and Terminology” on page 23. 

6. Select the Desired Subnet Size. 

Note: Typically, in subnets defined to contain more than 2 IP addresses, the 
first and last addresses are reserved as the network address, for identifying 
the subnet to the rest of the network, and the broadcast address, for 
communicating with all addresses within the subnet, respectively. As a result, 
the number of available IP addresses is always two fewer than the number 
actually contained within a given subnet. 

7. If you only want to see subnets that have already been allocated, clear 
Show subnets not already allocated. 

8. Click Refresh to display a list of all possible subnets that may be allocated, 
based on your provided criteria. 

9. Check the subnets you want to manage in Orion IPAM, and then click Next. 

10. If you want to view the subnets you are currently adding, click + next to 
the XX Selected Subnets header. 
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11. If you do not want to keep the supernet you used on the previous view 
to define the subnets you are adding, clear Add Supernet ‘X.X.X.X / X’. 

Note: By default, Orion IPAM adds the supernet you used to define your 
subnets to make it easier to organize your network. Although it is optional, 
SolarWinds recommends that you check this option and use the supernet 
unless you are only adding a few subnets. 

12. If you do not want to organize your added subnets into the smallest 
available supernet, clear Move newly added subnets into smallest 
appropriate supernet. 

Note: Adding subnets either to an existing supernet or to a newly defined 
supernet can make it easier to organize your network. Although it is optional, 
SolarWinds recommends that you check this option and keep the supernet 
unless you are only adding a few subnets. 

13. If you want to further identify your new subnets, provide a Description, 
VLAN ID, or Location for the new subnets. 

14. If you do not want Orion IPAM to automatically scan your new subnets 
for changes, check Disable Automatic Scanning. 

15. If you want Orion IPAM to automatically scan your new subnets for 
changes, use the slider to set the Scan Interval. 

16. Click Done when you have completed configuring your new subnets. 

Managing Supernets in Orion IPAM 
Supernets are extremely useful organizational tools for managing your network. 
The following sections detail the creation and editing of supernets in Orion IPAM. 

Creating Supernets 
The following procedure creates a new supernet for organizing your network 
components. 

To create a new network supernet: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses. 

3. In the network tree pane on the left, click the network, supernet, or group into 
which you want to add your new supernet. 

4. Click Add > Supernet. 

5. Provide an appropriate Supernet Name for your new subnet. 

Note: If you leave this field empty, Orion IPAM automatically generates a 
name based on the Supernet Address and CIDR prefix length you provide. 
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6. Provide a new Supernet Address and an appropriate CIDR prefix length for 
the new subnet. 

Note: Orion IPAM instantly confirms the validity of provided Supernet 
Address and CIDR prefix length combinations. For more information about 
CIDR and supernet addressing, see “Networking Concepts and Terminology” 
on page 23. 

7. If you want to further identify your new supernet, provide a Description 
for the new supernet. 

8. If you have already defined any custom fields for supernets, provide 
appropriate values in the available custom fields. For more information about 
configuring custom fields in Orion IPAM, see “Creating and Configuring 
Custom Fields” on page 17. 

9. When you have completed configuring your new supernet, click Save. 

You can now drag-and-drop your new supernet into other groups and supernets 
and drag-and-drop other supernets and subnets into your new supernet to 
organize your network. 

Editing Supernets 
The following procedure edits the properties of an existing supernet. 

To edit an existing network supernet: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click Manage Subnets & IP Addresses. 

3. Click the supernet you want to edit in the left tree pane. 

4. Click Properties. 

5. Edit the existing Supernet Name and the CIDR prefix length for your 
supernet. 

Note: Orion IPAM instantly confirms the validity of provided Supernet 
Address and CIDR prefix length combinations. For more information about 
CIDR and supernet addressing, see “Networking Concepts and Terminology” 
on page 23. 

6. Edit the Description for your subnet, as necessary. 

7. If you have defined custom fields for supernets, edit the values in the 
available custom fields, as necessary. For more information about 
configuring custom fields in Orion IPAM, see “Creating and Configuring 
Custom Fields” on page 17. 

8. When you have completed configuring your supernet, click Save. 



 

 
48  Using Orion IPAM 

Monitoring DHCP Servers 
DHCP Scope Monitoring allows you to add/edit DHCP Servers and configure 
their scan settings.  

To add a DHCP server 

1. Click on the DHCP Scope Monitoring tab. 

2. Click DHCP Servers. 

3. Click Add New > DHCP Server. 

4. Select the DHCP node to be added from the list of nodes. 

5. Choose or create the necessary Windows Credentials from the drop 
down list. Then click TEST to verify the credential.  

6. Select the Server Scan Settings. Default is set to 4 hours. 

7. If you want to automatically add new scopes and subnets after scanning, 
check the box. 

8. If you want to IPAM to scan using ICMP and SNMP to obtain additional 
IP Address details, check the Enable subnet scanning box and select 
the scanning interval. 

9. To finish, click ADD DHCP SERVER 

Note: Only Microsoft DHCP Servers on Windows 2003 and 2008 are 
supported. DHCP Servers must already be defined as Nodes within Orion 
NPM. All Windows credentials are sent in clear text during configuration only. 
The Windows account specified within IPAM must be on the DHCP server 
and one of the three following groups: DHCP Users, DHCP Administrators 
and or local Administrators. IPAM impersonates the specified account on the 
local computer to gain access. If the IPAM computer is not within the same 
windows domain as the DHCP server, the IPAM computer must have the 
identical account and password. 

Editing DHCP Servers 
The following procedure edits the properties of an existing DHCP Server. 

To edit an existing DHCP Server: 

1. Click on the DHCP Scope Monitoring tab. 

2. Select the DHCP Server that you want to edit by checking the box. 

3. Click Edit Server. 

4. Edit as necessary and then click Save. 
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Note: The edited properties are fields specific to IPAM and not related to any 
data in the DHCP server. 

Removing Servers 
The following procedure will remove an existing DHCP Server. 

To remove an existing DHCP Server: 

1. Click on the DHCP Servers tab. 

2. Select the DHCP Servers that you want to remove by checking the boxes. 

3. Click Remove Servers. 

4. Click Delete Listed Items 

DHCP Graph View 
The Graph View tab presents a graphical representation of the selected DHCP 
Servers IP Address percentage use. Unless certain Scopes/Servers are 
selected, the DHCP graph view will collect statistics for what is visible in the 
current tab. 

To view a DHCP Server Graph View: 

1. Click on the DHCP Servers tab. 

2. Select the DHCP Servers that you want to graph by checking the 
boxes. 

3. Click Graph View. 

Monitoring DHCP Scopes in Orion IPAM 
 The following sections detail the creation and editing of DHCP Scopes in Orion 
IPAM. 

Creating Scopes 
The following procedure creates a new DHCP Scope for organizing your network 
components. 

To create a new DHCP Scope: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click DHCP Scope Monitoring. 

3. Click Scopes. 

4. Click Add New > Found DHCP Scope. 
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5. Select the DHCP node to be added from the list of nodes. 

Note: All DHCP servers must already exist as nodes within Orion NPM. 

Choose or create the necessary Windows Credentials from the drop down list. 
Then click TEST to verify the credential.  

6. Select the Server Scan Settings. Default is set to 4 hours. 

7. If you want to automatically add new scopes and subnets after 
scanning, check the box. 

8. If you want to IPAM to scan using ICMP and SNMP to obtain additional 
IP Address details, check the Enable subnet scanning box and select the 
scanning interval. 

9. To finish, click ADD DHCP Scope 

Note: Only Microsoft DHCP Servers on Windows 2003 and 2008 are 
supported. DHCP Servers must already be defined as Nodes within Orion 
NPM. All Windows credentials are sent in clear text during configuration only. 
The Windows account specified within IPAM must be on the DHCP server 
and one of the three following groups: DHCP Users, DHCP Administrators 
and or local Administrators. IPAM impersonates the specified account on the 
local computer to gain access. If the IPAM computer is not within the same 
windows domain as the DHCP server, the IPAM computer must have the 
identical account and password. 

Editing DHCP Scopes 
The following procedure edits the text properties of an existing IPAM DHCP 
Scope.  

To edit an existing DHCP Scope: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click DHCP Scope Monitoring. 

3. Click Scopes. 

4. Select the Scope Name that you want to edit by using the check box. 

5. Click Edit Scope in the Modules menu bar. 

6. Edit as necessary and then click Save. 

Note: The edited properties are fields specific to IPAM and not related to any 
data in the DHCP server. 
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Removing Scopes 
The following procedure will remove an existing DHCP Scope. 

To remove an existing DHCP Scope: 

1. Click IP Address Manager in the Modules menu bar. 

2. Click DHCP Scope Monitoring. 

3. Click Scopes. 

4. Click on the Scopes tab. 

5. Select the DHCP Servers that you want to remove by checking the boxes. 

6. Click Remove Servers. 

7. Click Delete Listed Items 
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Chapter 4 

Creating Reports with Orion IPAM 

Orion IPAM uses the Orion NPM Report Writer to create reports for viewing on 
the web console or for scheduling reports to email and printout. By using the 
capabilities of Orion Report Writer, Orion IPAM data can be extracted and 
presented in a useful format. Orion Report Writer allows you to format your data 
and preview reports before you display them. When you have finished editing 
your reports, you can use the scheduler tool to schedule report emails and 
enable them for viewing through the Orion Web Console. For more information 
about adding reports to Orion Web Console views, see "Customizing Views" in 
the SolarWinds Orion Network Performance Monitor Administration Guide. 

Getting Started with Report Writer 
Before you can use Orion Report Writer, you must have collected at least a few 
minutes worth of data. The following procedure starts Report Writer. 

To start Report Writer: 

1. Click Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 
Mapping > Report Writer. 

2. Click File > Settings. 

3. In the General tab of the Report Writer Settings window, select either of the 
following as a default viewing mode: 

• Preview displays the report as it will appear in printed form. For more 
information, see “Report Writer Preview” in the SolarWinds Orion 
Network Performance Monitor Administration Guide. 

• Report Designer is the report creation and editing interface. For more 
information, see “Design Mode” on page 54. 

Note: You can toggle between Preview and Report Designer modes at any 
time by clicking Preview or Design, respectively, on the toolbar. 

4. If you want to separate the data for individual network objects with 
horizontal lines, click Report Style, and then check Display horizontal 
lines between each row. 

5. Click OK to exit Report Writer Settings.  



 

 
54  Using Orion IPAM 

Preview Mode 
Preview mode shows a report as it will print. When you open a report in Preview 
mode, or switch to Preview mode from Design mode, Orion NPM runs the query 
to generate the report and Report Writer displays the results. 

The Preview window toolbar provides the following actions and information: 

• Current page number and total number of pages in the report in the form 
current# / total# 

• Page navigation buttons: First Page, Page Up, Page Down, and Last Page 

• Zoom views 

Note: Double-click on a report preview to zoom in and double-right-click to 
zoom out. 

• Print report 

Design Mode 
Use Design mode to create new reports and modify or rename existing reports. 
The options available for both creating and modifying reports are the same. 
Design mode options are also dynamic, based upon the type of report, included 
report data, and report presentation. Available options differ according to the type 
of report that you are designing, but all reports require that you select the data to 
include and decide how that data will be sorted, ordered, filtered, and presented.  

Using Predefined Orion IPAM Reports 
Orion IPAM provides a number of predefined reports that may be viewed and 
edited in Orion Report Writer.  

To access these reports by clicking on Start > All Programs > SolarWinds 
Orion > Alerting, Reporting, and Mapping > Report Writer. 

The left pane presents all the currently available reports. IPAM related reports 
are grouped under Current IPAM Statistics. The following section provides brief 
descriptions of the predefined reports that are available with Orion IPAM. 

Predefined Orion IPAM Current IPAM Statistics Report 
The following predefined statistics reports are included with Orion IPAM and can 
be modified to your needs. 

IPAM - All available IP Addresses 

Displays all available IP addresses on your network designated as Available. 
For each IP address, this report provides the Display Name, Reverse DNS, 
System Name and MAC Address. 
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IPAM - All reserved IP Addresses 

Displays All reserved IP Addresses in IP Networks including the Display 
Name, Ipv4 Address, Reverse DNS, and System Name. 

IPAM - All used IP Addresses 

Displays All used IP Addresses in IP Networks including the Display Name, 
Ipv4 Address, Reverse DNS, and System Name. 

IPAM - All Subnets 

Displays the total usage percentage of all Subnets including the total 
percentage of allocated, used, transient, available and reserved IPs.   

Predefined Orion IPAM Events Report 
The following predefined Event reports are included with Orion IPAM and can be 
modified to your needs. 

IPAM Last 250 Events 

Displays the last 250 IPAM events including event time, event type icon, 
username, event type names, and event message. 

Opening Predefined IPAM Reports 
Use the following procedure to modify or create reports in Report Writer. 

To open a predefined report with Report Writer: 

1. If you want to modify an existing report, click an existing report from the 
inventory in the left pane of the main Report Writer window. 

2. If you want to create a new report, click File > New Report, select the type 
of report that you would like to create, and then click OK. 

Each report offers different configuration options on the separate tabs of the 
Report Designer, so, depending on the report, some of the formatting tabs 
described in the following sections may not be available.  

Notes: 

• The SQL query used to generate a report may be viewed in an additional tab. 
Click Report > Show SQL to add a read-only SQL tab to the Design window. 

• A preview of your report is also available at any time. Click Preview to enter 
Preview Mode, and then click Design to return to Design Mode. 
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Orion IPAM Report Attributes 
The following sections provide attributes for use within Orion IPAM reports. 

IPAM Network Statistics Attributes 
Values for reporting on IPAM Network Statistics include the following attributes. 

Statistics Attributes Description 

Network Address Network address 

Address Sort Key IP Address sort key 

CIDR Classless Inter-Domain Routing 

Display Name Name given to particular IP addresses 

Group Type Group name given to a particular group of IP addresses 

MASK Subnet Mask 

Comments User supplied comments 

VLAN ID VLAN ID 

Location Location of subnet 

Scan Interval Selected scanning interval 

Last Discovery Last completed discovery  

IP: Allocated Allocated IP Address's  

IP: Used IP address in a used state 

IP: Transient IP address in transient state 

IP: Total Total number of IP Addresses 

IP: Reserved Number of IP addresses in reserved state 

IP Available Number IP addresses available 

IP: % Usage Total % of IP usage 

IP: % Allocated Total % of allocated IPs 
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IPAM Node Attributes 
Values for reporting on specific IP nodes include the following attributes. 

Node Attributes Description 

SubnetID Subnet Identifier 

IPv4 Address Displays IPv4 addresses 

IPv4 Sort Key Key Sort 

IPv6 Address Displays IPv6 addresses 

Alias Device know as 

Reverse DNS DNS Name 

System Name System Name  

MAC MAC Address 

Contact Who to Contact 

Description Description 

 Location Location of  the Device 

System ObjectID System Object Identifier 

Vendor Device manufacturer 

VendorIcon Icon of the device vendor 

Machine Type Machine Type given 

Comments User Comments 

Response Time Current Response Time 

Last Synchronization Last Synchronization with database 

Status Current IP Status 

Type Type of device 

Last Boot Time Last time entered for reboot 
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IPAM Event Attributes 
Values for reporting on specific IPAM Events Log include the following attributes: 

Event Attributes Description  

Event Time  Time the event occurred 

Message Displays the message event 

Event Type Displays the event type 

Event Type Icon Event type icon 

Event Type Name Event type name 

Acknowledged Event has been acknowledged 

Username Username 

Common Event Type Displays Object Type 

General Options Tab 
The General tab opens by default and shows titling and display options that may 
be configured as follows. 

To configure General options: 

1. Specify the Report Group, Report Title, Subtitle, and Description. 

Note: If you use an existing report group name, the new report is added to 
that existing group in the left pane of the main window. 

2. Select the display Orientation of your report. 

3. If you do not want to make this report available on your Orion Web 
Console, clear Make this Report available from the Orion website. 

Note: By default, most reports are made available for display in the Orion 
Web Console. For more information about adding reports to Orion Web 
Console views, see “Viewing Reports” on page 62. 



 

 
Using Orion IPAM  59 

Select Fields Options Tab 
The Select Fields tab allows you to select the data fields in a report, as shown in 
the following procedure. 

To select and configure fields: 

1. Click Select Fields. 

2. If you are creating a new report or adding fields to an existing report, 
click the ellipsis, select Add a new field, and then dynamically define each 
new report field as follows: 

a. Click the asterisk after Field: and select the type of information that you 
want to include in the current report field. 

b. If you want to sort the data in the current field, click the sort asterisk 
and select a sort order. 

c. If you want to perform an operation on the data in the current field, 
click the function asterisk and select an operation. 

3. If you are modifying an existing report, click the Field, sort, or function 
that you want to change and select a new value as follows. 

a. Click the asterisk after Field: and select the type of information that you 
want to include in the current report field. 

b. If you want to sort the data in the current field, click the sort asterisk 
and select a sort order. 

c. If you want to perform an operation on the data in the current field, 
click the function asterisk and select an operation. 

4. If you want to test your selections as you assemble your report, click 
Execute SQL Query to view the current query results. 

5. If you want to preview your report, click Preview. 

Note: Click Design in the toolbar to return to the Design Mode window. 

6. If you want to delete a field or rearrange the order of the fields that are 
listed in your report, select a field, click Browse (…), and then select the 
appropriate action. 

Note: Unchecked fields are not displayed in your report, but their sort and 
function configurations are retained. 
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Report Grouping Options Tab 
The Report Grouping tab allows you to group results by field descriptor within 
your report. Add, edit and delete report groups to organize the data in your 
report. Establish and edit report groups as follows. 

To add and edit report groups: 

1. If you want to add a new report group, select a field from the list to define 
your group, and then click Add Report Group to add your selected field to 
the Report Groups list.  

Note: Use up and down arrows to change the grouping order accordingly. 

2. If you want to edit an existing report group, select the field from the 
Report Groups list, and then click Edit Report Group.  

3. The following options may be changed as needed: 

• The Group Header is the text that designates groups on your report. 

• The Web URL is the dynamic location of your published report with 
respect to your Orion Web Console. 

• Font size, face, color, and background may all be modified by clicking 
associated ellipses. 

• Alignment may be left, center, or right. 

• Check Transparent Background for better results when publishing your 
report to the Web. 

• If you want to change the grouping order, use the up and down arrows to 
change the grouping order accordingly. 

Field Formatting Options Tab 
The Field Formatting tab allows you to customize the format of the various 
results fields in your report. To format results fields, select the field you want to 
format, and then edit labels and select options as appropriate. 

Notes: 

• The formatting options available for each field may be different according to 
the nature of the data contained in that field. 

• Check Hidden Field to hide any field in your report. 

• To view your changes at any time, click Preview. 
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Customizing the Report Header and Footer Image 
The image that is displayed at the top and bottom of each report can be 
changed. To add your company logo as the report header and footer, save your 
logo as Header.jpg in the SolarWinds\Common\WebResources folder, typically 
located in C:\Program Files\, and then click Refresh. 

Note: The image must be in JPEG format with a height of 150 pixels or less. 

Exporting Reports 
Orion Report Writer gives you the ability to present your created reports in a 
variety of different, industry-standard formats. The following formats (and 
extensions) are currently supported: 

• Comma-delimited (*.csv, *.cdf) 

• Text (*.txt) 

• HTML (*.htm, *.html) 

• MIME HTML, with embedded images (*.mhtml) 

• Excel® spreadsheet (*.xls) 

• Adobe® PDF (*.pdf) 

• Image (*.gif) 

The following procedure presents the steps required to export an open report 
from Orion Report Writer into any of the previously listed formats. 

To export a report from Report Writer: 

1. Select a report to export by clicking any of the following: 

• Select a report from the file tree in the left pane 

• File > Open to open an existing report 

• File > New Report to create a new report. For more information about 
creating reports, see “Error! Reference source not found.” on 
page Error! Bookmark not defined.. 

2. Select File > Export and then click the format in which you want to export 
your report: 

3. Check the fields in your open report that you want to export into the selected 
format, and then click OK. 

4. Select a location to save your file. 

5. Provide a File name, and then click Save. 
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Viewing Reports 
All reports, custom or predefined, are available for viewing in Report Writer, as 
shown in the following procedures. 

To view reports with Orion IPAM Report Writer: 

1. Click Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 
Mapping > Report Writer. 

2. Click + next to a report group name to expand the group. 

3. Click the title of the report you want to view. 

4. Click Preview. 

Scheduling Reports 
Orion NPM provides a scheduling tool to schedule report emails and printouts. 

To schedule a report: 

1. Click Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 
Mapping > Orion Report Scheduler. 

2. Click Edit > Add New Job. 

3. Type a name for your new report scheduler job, and then click Continue. 

4. Click Browse (…) button, and then browse to the report you want to send in 
the Orion Web Console. 

5. Click Use Current URL. 

6. If you want to exclude the Orion NPM web page banner and menu bar, 
check Retrieve a Printable Version of this Page. 

7. Check Send Orion Username / Password in URL. 

8. Provide the user account credentials needed to view the Orion NPM web 
report. 

9. If you need to provide Windows login credentials, click the NT Account 
login tab, and then provide the user account details needed to log in. 

10. Click Continue. 

11. Provide the appropriate schedule interval for your job, and then click 
Continue. 
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12. If you want to email the report, complete the following procedure: 

a. Ensure Email the Web Page is selected. 

b. Provide the email addresses and subject in the appropriate fields on the 
Email To tab. 

c. Provide name and reply address in the appropriate fields on the Email 
From tab. 

d. Type the hostname or IP address of the SMTP server and port number 
on the SMTP Server tab. 

13. If you want to print the report, click Print the Web Page, select the printer, 
orientation, and number of copies you want to print. 

14. Click Continue. 

15. Type the Windows user account details, and then click Continue. 

16. Type any comments you want to add to the job description, and then click 
Finish. 

 

Using Alerts with Orion IPAM 

Orion IPAM provides the ability to alert on high Subnet and DHCP scope 
utilizations. By default, Orion IPAM provides advanced alerts that are configured 
at install. The following alerts are available and functional as soon as Orion IPAM 
is installed, giving you immediate insight into the status and performance of your 
subnets and DHCP scope management: 

• High DHCP Scope Usage Monitoring. This alert will write to IPAM event log 
when a scopes usage surpasses 75% 

• High Subnet Usage Monitoring. This alert will write to IPAM event log when a 
subnets usage surpasses 75% 

When you first log on to the Orion Web Console, if there are any devices on your 
network that trigger any of these alerts, the Active Alerts resource on the Network 
Summary Home view displays the triggered alerts with a brief description. You 
can then acknowledge these alerts from the Alerts view. 

Viewing Alerts in the Orion IPAM Web Console 
The Triggered Alerts for All Network Devices page provides a table view of your 
alerts log. You can customize the list view by using the following procedure to 
select your preferred alert grouping criteria. 
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To view alerts in the Web Console: 

1. Click Start > All Programs > SolarWinds Orion > Orion Web Console. 

2. Click Alerts in the Views toolbar. 

3. If you want to filter your alerts table view by Scopes, select the Scope to 
which you want to limit your alerts view in the Network Object field. 

4. If you want to filter your alerts table by type of Scope, select the Scope 
type to which you want to limit your alerts view in the Type of Device field. 

5. If you want to limit your alerts table to show a specific type of alert, 
select the alert type in the Alert Name field. 

6. In the Show Alerts field, provide the number of alerts you want to view. 

7. If you want to show all alerts, even if they have already been cleared or 
acknowledged, check Show Acknowledged Alerts. 

8. Click Refresh to complete your Alerts view configuration. 

Viewing Alerts in Orion NPM System Manager 
The Active Alerts window displays a table view of your alerts log. You can 
customize the list view by using the following procedure to select your preferred 
alert grouping criteria. 

To view alerts in System Manager: 

1. Click Start > All Programs > SolarWinds Orion > System Manager. 

2. Click Alerts > Active Alerts. 

3. Select Advanced Alerts. 
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4. If you are viewing advanced alerts, customize your Active Alerts display as 
follows: 

a. Select from the following options in the Group By list to change your 
Active Alerts view: Alert Name, Object Type, Object Name, Alert 
State, Acknowledged, Acknowledged By, or No Grouping. 

b. Order your Alerts list by any of the following criteria by clicking the 
appropriate column: Acknowledged, Alert Name, Alert State, Object 
Name, Triggered Time, Acknowledged By, or Acknowledge Time. 

 

5. Click Refresh at any time to display the most recently triggered alerts. 

Creating and Configuring Advanced Alerts 
The Orion IPAM advanced alert engine allows you to configure alerts with the 
following features: 

• Sustained state trigger and reset conditions 

• Multiple condition matching 

• Automatic alert escalation 

• Separate actions for triggers and resets 

Advanced alerts are configured using the Advanced Alert Manager. For more 
information about the Advanced Alert Manager, see "Creating and Configuring 
Advanced Alerts" in the SolarWinds Orion Network Performance Monitor 
Administrator Guide. 

Note: If you want to configure advanced alert features, such as timed alert 
checking, delayed alert triggering, timed alert resets, or alert suppression, check 
Show Advanced Features at the lower left of any Advanced Alert windows. For 
the purposes of this document, Show Advanced Features should always be 
enabled. 

IPAM Advanced Alert Example 
The following procedure modifies an existing advanced alert. 

To modify a default advanced alert: 

To set the trigger conditions for an advanced alert: 

1. Click Start > SolarWinds Orion > Alerting, Reporting, and Mapping > 
Advanced Alert Manager. 

2. Click View > Configure Alerts. 
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3. Click High Subnet Usage Monitoring. 

4. Click Edit. 

5. Click Trigger Condition. 

6. Add a Simple Condition  

7. Click Add a Simple Condition. 

8. Click Browse (…) and set to CIDR: 

9. If you need an additional condition, click Add, and then select the type of 
condition you want to add. 

10. If you need to delete a condition, select the condition from the condition 
list, and then click Delete. 

Notes:  

• Conditions may be exported for use with other alerts by clicking Export 
Conditions and saving as appropriate. 

• Click Import Conditions to import existing conditions from other alerts. 

Warning: Imported trigger conditions automatically overwrite any 
existing trigger conditions. 

 
11. If you want to specify a time duration for the condition to be valid, type 

the time interval and select Seconds, Minutes, or Hours from the list. 

Note: You may need to delay alert trigger actions until a condition has been 
sustained for a certain amount of time. For example, an alert based on CPU 
load would not trigger unless the CPU Load of a node has been over 80% for 
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more than 10 minutes. To set up a sustained-state trigger condition, at the 
bottom of the Trigger Condition tab, provide an appropriate amount of time 
the alert engine should wait before any actions are performed. By default, the 
alert triggers immediately, if the trigger condition exists. The maximum alert 
action delay is eight hours after the trigger condition is met. 

12. If you are finished configuring your advanced alert, click OK. 

To learn more about the Advanced Alerting capabilities, including reset 
conditions, alert suppression, trigger and reset actions for an Advanced Alert see 
"Creating and Configuring Advanced Alerts" in the SolarWinds Orion Network 
Performance Monitor Administrator Guide. 
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Chapter 5 

Additional Orion IPAM Features 

As an Orion module, Orion IPAM provides access to both the SolarWinds 
Engineer Toolset integration and thwack, the SolarWinds online community. 

Integrating SolarWinds Engineer’s Toolset with Orion 
IPAM 
When you are browsing the Orion Web Console from a computer that has 
SolarWinds Engineer’s Toolset installed, you can launch Toolset tools directly 
from your web browser. Right-clicking on any node, interface, or volume will 
display a menu of available Engineer’s Toolset tools and functions. The following 
procedure configures SolarWinds Engineer’s Toolset for integration within the 
Orion Web Console. 

Note: The first time the Toolset tools are accessed, a security warning may be 
displayed. Click Yes to allow the toolset integration. 

To configure Engineer’s Toolset integration settings: 

1. Right-click on any node, interface, or volume from within the web console. 

2. Click Settings, and then click SNMP Community String. 

Note: The first time a tool requiring an SNMP community string is launched 
from the right-click menu, the Add Community String window is displayed. 
If the option Remember this community string is checked, the community 
string will be saved for future access. 

3. If you want to delete any or all saved community strings, select the 
strings that you want to delete, and then click Remove, or click Remove All. 

4. Click Menu Options, and then configure the right-click menu as follows: 

a. If you want to add or remove menu items from the right-click menu, 
move menu items between the list of Available Menu Options on the 
left and Selected Menu Options on the right by selecting items in either 
column and clicking the right and left arrows, as appropriate. 

b. If you want to change the order of menu items, select items and then 
click the up and down arrows next to the Selected Menu Options list. 

c. If you want to add a separator between items, move the "--------------" 
menu option from the Available list to the Selected list, and then move it 
to your preferred location within the Selected Menu Options list. 
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5. Click Automatic Menu Items. 

6. Check either or both of the following options: 

• Automatically add sub-menu items to the “MIB Browser (Query 
MIB)” menu option from the MIB Brower’s Bookmarks. 

• Automatically add sub-menu items to the “Real Time Interface 
Monitor” menu option from the Real-Time Interface Monitor saved 
report types. 

Note: These options expand the list of available menu items by incorporating 
menu links to MIB browser bookmarks and Real-time Interface Monitor saved 
reports, respectively. 

Interacting with the thwack User Community 
thwack is a community site that SolarWinds developed to provide users and the 
broader networking community with useful information, tools and valuable 
resources related to SolarWinds network management solutions. Resources that 
allow you both to view recent posts and to search all posts are available from the 
Orion Web Console, providing direct access to the thwack community. IPAM 
comes with the Thwack integration imbedded in the resource page.  

thwack Recent Orion Posts Resource 
This resource shows the most recent Orion IPAM posts that have been submitted 
to thwack.com, the online SolarWinds user community. Clicking any post title 
listed in the resource opens the associated post in the IPAM forum. 

1. Click the title of a listed post to open in a new browser. 

2. Click Edit to set the number of posts to display in the resource.  

3. Click View All to see a list of all Orion IPAM posts  

4. Click Submit when you are done. 

5. To remove this resource from view Click Customize Page and select 
thwack.com in the resource column. 

6. Click the red x. and click Done. 

Providing Feedback 
thwack also offers the ability to submit product feedback and feature requests via 
the IPAM Feature requests forum. You may navigate to that forum via the thwack 
forums page. 
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